5,770,951; 5,773,993; 5,778,439; 5,781,756; 5,784,313; 5,784,577; 5,786,240; 5,787,007; 5,789,938; 5,790,479; 
5,790,882; 5,795,068; 5,796,269; 5,798,656; 5,801,546; 5,801,547; 5,801,548; 5,811,985; 5,815,004; 5,815,016; 
5,815,404; 5,815,405; 5,818,255; 5,818,730; 5,821,772; 5,821,774; 5,825,202; 5,825,662; 5,825,787; 5,828,230; 
5,828,231; 5,828,236; 5,828,608; 5,831,448; 5,831,460; 5,831,845; 5,831,907; 5,835,402; 5,838,167; 5,838,901; 
5,838,954; 5,841,296; 5,841,867; 5,844,422; 5,844,424; 5,844,829; 5,844,844; 5,847,577; 5,847,579; 5,847,580; 
5,847,993; 5,852,323; Re. 34,363, Re. 34,444, and Re. 34,808. Other U.S. and foreign patents pending. Xilinx, 
Inc. does not represent that devices shown or products described herein are free from patent infringement or from 
any other third party right. Xilinx, Inc. assumes no obligation to correct any errors contained herein or to advise 
any user of this text of any correction if such be made. Xilinx, Inc. will not assume any liability for the accuracy or 
correctness of any engineering or software support or assistance provided to a user.

Xilinx products are not intended for use in life support appliances, devices, or systems. Use of a Xilinx product in 
such applications without the written consent of the appropriate Xilinx officer is prohibited.

Copyright 1991-1999 Xilinx, Inc. All Rights Reserved.
About This Manual

This manual describes the Xilinx Constraints Editor, a tool used for creating and modifying constraints.

Before using this manual, you should be familiar with the operations that are common to all Xilinx software tools: how to bring up the system, select a tool for use, specify operations, and manage design data. These topics are covered in the Alliance Quick Start Guide and the Foundation Quick Start Guide. Other publications you can consult for related information are the Libraries Guide, Design Manager/Flow Engine Guide, and the Development System Reference Guide.

Additional Resources

For additional information, go to http://support.xilinx.com. The following table lists some of the resources you can access from this page. You can also directly access some of these resources using the provided URLs.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description/URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutorial</td>
<td>Tutorials covering Xilinx design flows, from design entry to verification and debugging <a href="http://support.xilinx.com/support/techsup/tutorials/index.htm">http://support.xilinx.com/support/techsup/tutorials/index.htm</a></td>
</tr>
<tr>
<td>Answers Database</td>
<td>Current listing of solution records for the Xilinx software tools Search this database using the search function at <a href="http://support.xilinx.com/support/searchtd.htm">http://support.xilinx.com/support/searchtd.htm</a></td>
</tr>
<tr>
<td>Application Notes</td>
<td>Descriptions of device-specific design techniques and approaches <a href="http://www.support.xilinx.com/apps/appsweb.htm">http://www.support.xilinx.com/apps/appsweb.htm</a></td>
</tr>
</tbody>
</table>
Manual Contents

This manual covers the following topics.

• Chapter 1, “Introduction”—Describes the Constraints Editor interface.

• Chapter 2, “Getting Started”—Describes opening the Constraints Editor and using the interface.

• Chapter 3, “Menu Commands”—Describes the commands available from the Constraints Editor menus.

• Chapter 4, “Using the Constraints Editor”—Describes how to use the Constraints Editor to perform various tasks.

• Chapter 5, “Windows and Dialog Boxes”—Describes the Constraints Editor windows and dialog boxes and their functions.

• Appendix A, “UCF Syntax”—Describes constraints syntax as it appears in the UCF (User Constraints File).
Conventions

This manual uses the following typographical and online document conventions. An example illustrates each typographical convention.

Typographical

The following conventions are used for all documents.

• Courier font indicates messages, prompts, and program files that the system displays.

  speed grade: -100

• Courier bold indicates literal commands that you enter in a syntactical statement. However, braces "{ }" in Courier bold are not literal and square brackets "[ ]" in Courier bold are literal only in the case of bus specifications, such as bus [7:0].

  rpt_del_net=

  Courier bold also indicates commands that you select from a menu.

  File → Open

• Italic font denotes the following items.
  • Variables in a syntax statement for which you must supply values

    edif2ngd design_name

  • References to other manuals

    See the Development System Reference Guide for more information.
• Emphasis in text

If a wire is drawn so that it overlaps the pin of a symbol, the two nets are not connected.

• Square brackets “[ ]” indicate an optional entry or parameter. However, in bus specifications, such as bus [7:0], they are required.

```plaintext
edif2ngd [option_name] design_name
```

• Braces “{ }” enclose a list of items from which you must choose one or more.

```plaintext
lowpwr = [on | off]
```

• A vertical bar “|” separates items in a list of choices.

```plaintext
lowpwr = [on | off]
```

• A vertical ellipsis indicates repetitive material that has been omitted.

```plaintext
IOB #1: Name = QOUT'
IOB #2: Name = CLKIN'
.
.
.
```

• A horizontal ellipsis “...” indicates that an item can be repeated one or more times.

```plaintext
allow block block_name loc1 loc2 ... locn;
```

## Online Document

The following conventions are used for online documents.

• Red-underlined text indicates an interbook link, which is a cross-reference to another book. Click the red-underlined text to open the specified cross-reference.

• Blue-underlined text indicates an intrabook link, which is a cross-reference within a book. Click the blue-underlined text to open the specified cross-reference.
Contents

About This Manual

Additional Resources ................................................................. i
Manual Contents ....................................................................... ii

Conventions

Typographical ............................................................................... iii
Online Document ......................................................................... iv

Chapter 1 Getting Started

Starting the Constraints Editor .................................................. 1-1
   From the Design Manager .................................................... 1-1
   As a Standalone ................................................................. 1-1
   From the Command Line ..................................................... 1-2
   From Xilinx Foundation Series ........................................... 1-2
Using the Interface ....................................................................... 1-2
   Main Window ......................................................................... 1-3
      Title Bar ........................................................................ 1-4
      Menu Bar ....................................................................... 1-4
      Toolbar .......................................................................... 1-4
      Common Fields ............................................................. 1-5
      Moving Items in List Boxes ........................................... 1-5
   Using the Mouse .................................................................... 1-5
   Using the Keyboard ............................................................. 1-6
Obtaining Online Help ............................................................... 1-6
   Help Menu ......................................................................... 1-6
   Toolbar Help Button ......................................................... 1-7
   Help Button in Dialog Boxes ............................................. 1-7
   F1 Key .............................................................................. 1-7
Exiting the Constraints Editor .................................................... 1-8
Constraints Editor Guide

Chapter 2 Menu Commands

File Menu ................................................................. 2-1
View Menu ................................................................. 2-2
Window Menu ............................................................... 2-2
Help Menu................................................................. 2-2

Chapter 3 Using the Constraints Editor

Loading Files ........................................................................ 3-1
Creating and Modifying Constraints ...................................... 3-5
  From the Global Tab Window ......................................... 3-5
    Clock Period ................................................................. 3-6
    Pad to Setup .................................................................. 3-8
    Clock to Pad .................................................................. 3-9
    Pad to Pad ..................................................................... 3-10
  From the Ports Tab Window .............................................. 3-11
    Location ...................................................................... 3-12
    Pad to Setup .................................................................. 3-12
    Clock to Pad .................................................................. 3-13
    I/O Configuration Options ............................................ 3-14
    Prohibit I/O Locations .................................................. 3-15
    Pad Grouping ................................................................. 3-16
  From the Advanced Tab Window ........................................ 3-17
    Group Elements Associated by Nets (TNM_NET) .............. 3-18
    Group Elements by Instance Name (TNM) ...................... 3-20
    Group Elements by Element Output Net Name
    Schematic Users (TIMEGRP) ......................................... 3-20
    Timing THRU Points (TPTHRU) ...................................... 3-22
    Pad to Setup Requirement(s) for Groups of Pads
      and/or Registers (OFFSET IN BEFORE) ....................... 3-23
    Clock to Pad Requirement(s) for Groups of Pads
      and/or Registers (OFFSET OUT AFTER) ....................... 3-24
    Slow/Fast Path Exceptions (FROM TO) ......................... 3-26
    Multicycle Paths (FROM TO) ........................................ 3-28
    False Paths (FROM TO TIG) ......................................... 3-30
    False Paths by Nets (NET TIG) ..................................... 3-32
    Prorating Voltage ......................................................... 3-34
    Prorating Temperature .................................................. 3-34
  From the Constraints Window ........................................... 3-35
  Viewing Constraints ....................................................... 3-35
  Output Window ............................................................. 3-36
Chapter 4  Windows and Dialog Boxes

Main Window .................................................................................. 4-2
Global Tab Window ........................................................................ 4-3
Ports Tab Window ......................................................................... 4-5
Advanced Tab Window .................................................................. 4-7
Constraints Dialog Boxes ............................................................... 4-10
  Clock Period Dialog Box ........................................................... 4-11
  Pad to Setup Dialog Box ........................................................... 4-13
  Clock to Pad Dialog Box ........................................................... 4-15
  Pad to Pad Dialog Box .............................................................. 4-17
  Location Dialog Box ................................................................ 4-18
  Prohibit I/O Locations Dialog Box ............................................. 4-18
  Time Name Dialog Box ............................................................. 4-20
  Time Group Dialog Box ............................................................. 4-21
  Timing THRU Point (TPTHRU) Dialog Box ............................... 4-23
  FROM/THRU/TO Dialog Box .................................................... 4-25
  Timing Ignore Dialog Box ......................................................... 4-28
  Voltage Dialog Box ................................................................... 4-30
  Temperature Dialog Box ............................................................ 4-30
Constraints Window ....................................................................... 4-31
Output Window............................................................................... 4-32

Appendix A  UCF Syntax

Group Elements Associated by Nets (TNM_Net) ....................... A-2
Group Elements by Instance Name (TNM) ................................. A-2
Group Elements by Element Output Net Name
  Schematic Users (TIMEGRP) ..................................................... A-2
Timing THRU Points (TPTHRU) .................................................. A-3
Pad to Setup .................................................................................. A-3
Clock to Pad ................................................................................ A-4
Slow/Fast Path Exceptions (FROM TO) ........................................ A-4
Multicycle Paths (FROM/THRU/TO) ......................................... A-5
False Paths (FROM TO TIG) ....................................................... A-5
False Paths by Net (Net TIG) ...................................................... A-6
Period .......................................................................................... A-6
Location ....................................................................................... A-6
Prohibit I/O Locations ............................................................... A-7
FAST/SLOW ................................................................................ A-7
PULLUP/PULLDOWN ................................................................. A-7
DRIVE ......................................................................................... A-8
IOSTANDARD (Virtex devices only) ............................................ A-8
Chapter 1

Introduction

This chapter introduces the Constraints Editor. It contains the following sections.

- “Overview”
- “Constraints Editor Main Window”
- “Global Tab Window”
- “Ports Tab Window”
- “Advanced Tab Window”
- “Constraints Window”
- “Output Window”
- “Input/Output Files”

Overview

Constraints are instructions placed on symbols or nets in an FPGA or CPLD schematic or textual entry file such as VHDL or Verilog. They can indicate a number of things such as placement, implementation, naming, directionality, and timing considerations. In the Xilinx development system, logical constraints (ones entered before a design is mapped to a device) are placed in a file called the UCF (User Constraints File).

The Constraints Editor is a Graphical User Interface (GUI) that eliminates the need for learning, remembering, and manually entering complicated syntax. Used in the implementation phase of the design after the translation step (NGDBuild), the Constraints Editor allows you to create and manipulate constraints without any direct editing of the UCF. After the constraints are created or modified with the Constraints Editor, NGDBuild must be run again, using the new UCF...
and design source netlist files as input and generating a new NGD file as output.

The Constraints Editor interface consists of a main window, three tab windows, a constraints window, an output window, and numerous dialog boxes. A brief description of the windows is included below. Window and dialog box functionality is described in the “Windows and Dialog Boxes” chapter.

The purpose of this guide is to describe the functionality and use of the Constraints Editor GUI. It does not include a detailed description of the constraints supported by the Constraints Editor. For in-depth information on specific constraints and constraints in general, please refer to the “Using Timing Constraints” chapter in the Development System Reference Guide and the “Attributes, Constraints, and Carry Logic” chapter in the Libraries Guide.

**Constraints Editor Main Window**

The main window is used to load files, to access the three tab windows (Global, Ports, and Advanced), to display editable or read-only constraints, and to display errors, warnings, and informational messages. The tab windows occupy the same space; only one window displays at a time. The figure below shows the appearance of the main window when you first open the Constraints Editor.
Figure 1-1  Constraints Editor Main Window (Empty)

The figure below shows you the appearance of the main window after you have loaded a file.
**Constraints Editor Guide**

For more about the main window, see the “Main Window” section in the "Windows and Dialog Boxes” chapter.

**Global Tab Window**

The Global tab window, which is displayed in the top half of the main window, consists of a grid showing all of the design’s clock nets and the associated period, pad to setup, and clock to pad values. See the “Constraints Editor Main Window (Loaded)” figure above. It also contains a field for displaying a global pad to pad value. The Global tab window is the default window that opens when a file is loaded into the Constraints Editor.
The “Global Tab Window” section in the “Windows and Dialog Boxes” chapter gives you more information on using the global tab window.

**Ports Tab Window**

The top portion of the Ports tab window is composed of a grid. The two leftmost columns of the grid contain the user names of all current ports and each port’s direction (input, output, or bidirectional). The other columns enable you to lock any user-defined port to a specified package pin (Location) and to enter any clock-specific constraint (Pad to Setup and Clock to Pad).
Located near the bottom of the Ports tab window are an I/O Configuration Options check box, a Prohibit I/O Locations button, and a field for selecting and creating pad groups, all of which are described briefly here.

I/O Configuration Options toggle box — When you click the empty box, a check mark appears in this box, and a number of additional columns (depending on the target device) are added to the grid in the Ports tab window, such as FAST/SLOW seen in the “Ports Tab Window” figure. For details on the additional columns, see the “I/O Configuration Options” section in the “Using the Constraints Editor” chapter.
**Prohibit I/O Locations** button—disallows an I/O location for use by PAR (Place and Route) and FPGA Editor.

**Pad Groups**—enables you to create or select pad groups to which a constraint can be applied.

The “Ports Tab Window” section in the "Windows and Dialog Boxes" chapter gives you more information on using the ports tab window.

## Advanced Tab Window

The Advanced tab window contains a number of fields for specifying grouping, timing constraints, and voltage and temperature prorating constraints.

![Advanced Tab Window](image)

**Figure 1-5  Advanced Tab Window**
The “Advanced Tab Window” section in the "Windows and Dialog Boxes" chapter gives you more information on using the Advanced tab window.

Constraints Window

The Constraints window is located in the bottom half of the main window directly above the Output window (see the figure below). Constraints are displayed in two groups, editable constraints and source constraints (read-only). The group displayed depends on the tab selected at the bottom of the window. As constraints are created, the UCF syntax appears in the editable group of the Constraints window. Constraints in the editable group are from the UCF and are editable by the Constraints Editor. Constraints in the source group are from the NCD and come from the netlist, the NCF, or the UCF (if the constraint is not supported by the Constraints Editor).

Figure 1-6 Constraints and Output Windows

By default, the Constraints window opens when you start the Constraints Editor, but it does not display information until you open a UCF/NGD file. For more on the Constraints window, see the “Constraints Window” section in the "Windows and Dialog Boxes" chapter.
Output Window

The Output window is located in the bottom half of the Main window directly below the Constraints window. It displays errors, warnings, and other information (see the “Constraints and Output Windows” figure).

By default, the Output window, like the Constraints window, opens when you start the Constraints Editor, but it does not display information until you open a UCF/NGD file.

Input/Output Files

The Constraints Editor requires a User Constraints File (UCF) and a Native Generic Database (NGD)file as inputs. The Constraints Editor used the NGD to provide names of logical elements for grouping. As output, it uses the UCF, including the changes made with the Constraints Editor.

After you open the Constraints Editor you must first open a UCF file. If the UCF and NGD root names are not the same, you must select the appropriate NGD file to open. For details on loading files, see the “Loading Files” section in the “Using the Constraints Editor” chapter.

Upon successful completion, the Constraints Editor writes out a UCF. NGDBuild (translation) uses the UCF, along with design source netlists, to produce an NGD file. The NGD file is read by the MAP program. MAP generates a physical design database in the form of an NCD (Native Circuit Description) file and also generates a PCF (Physical Constraints File). The implementation tools use these files to ultimately produce a bitstream. See the “Constraints Editor Flow” figure.
In this software release, not all Xilinx constraints are accessible through this GUI. Constraints supported in the GUI and the associated UCF syntax are described in the “UCF Syntax” appendix.
Chapter 2

Getting Started

This chapter describes getting started in the Constraints Editor. It contains the following sections.

• “Starting the Constraints Editor”
• “Using the Interface”
• “Obtaining Online Help”
• “Exiting the Constraints Editor”

Starting the Constraints Editor

The Constraints Editor runs on PCs and workstations. You can start it from the Xilinx Design Manager, as a standalone, or from the command line.

From the Design Manager

To start the software from the Design Manager window, select Constraints Editor from the Utilities menu.

As a Standalone

If you installed the Constraints Editor as a standalone tool on the PC, click the Constraints Editor icon (shown below) on the Windows desktop or select Constraints Editor from the Start menu.
From the Command Line

To start the Constraints Editor from the UNIX or DOS command prompt with no data loaded into the editor, type the following command.

```
constraints_editor
```

Below are variations for starting the Constraints Editor from the command line.

- The following command starts the Constraints Editor with the given NGD file loaded. If a UCF file with the same base name as the NGD file exists, it will be loaded also. Otherwise, you will be prompted for a UCF file.

```
constraints_editor ngdfile_name
```

where `ngdfile_name` is the name of the NGD file. It is not necessary to use the .ngd extension.

- The following command starts the Constraints Editor with the NGD file and the UCF file loaded into the editor.

```
constraints_editor ngdfile_name -uc ucf_file_name
```

where `ngdfile_name` is the name of the NGD file and `ucf_file_name` is the name of the UCF file. It is not necessary to use the .ucf extension.

- To run the tool as a background process on a workstation, type the following.

```
constraints_editor &
```

From Xilinx Foundation Series

In the Foundation Project Manager, select `Tools` → `Implementation` → `Constraints Editor`.

Using the Interface

This section describes the elements that compose the Constraints Editor interface and how to use them.

**Note:** Menus, dialog boxes, and parts of the application window are documented as they appear on a PC. Differences between the PC and
the workstation applications are noted if there is a difference in operation between the two platforms.

**Main Window**

This section describes the Constraints Editor’s main window. By default, the window contains a menu bar and toolbar at the top and a status bar at the bottom of the window. When you start the application, the main window appears, as shown in the following figure.

![Constraints Editor Main Window](image)

**Figure 2-1  Constraints Editor Main Window**

You can hide the status bar and toolbar from view by selecting **Toolbar** or **Status Bar** from the View menu.
Title Bar
The title bar displays the program name (always Constraints Editor) followed by the name of the active tab window and the names of opened NGD and UCF files; for example, Constraints Editor [Advanced - wwsc.ngd/wwsc.ucf].

Menu Bar
Commands are available in the pull-down menus when a design is loaded. Certain commands and some command options are disabled and not available, depending on whether the open design is for an FPGA or a CPLD.

You can select menu commands with the mouse or the keyboard. See the “Using the Mouse” or “Using the Keyboard” section for more information. When you select a menu command with either method, a brief description of the command’s function appears in the status bar at the bottom of the main window. In addition, some commands have keyboard shortcuts and accelerators. For complete command descriptions, see the “Menu Commands” chapter of this manual.

Toolbar
The toolbar appears at the top of the window just below the menu bar. The toolbar provides button access to frequently used commands in the menus. Textual labels for the buttons appear when you move the cursor arrow over a button. A longer description also appears in the status bar. On a PC, the toolbar can be arranged in a variety of ways. The toolbar can either be docked (that is, attached to the main window) or floating (that is, contained in its own window).

You can arrange the toolbar in these ways.

- To move the toolbar, point to a spot between toolbar buttons (or to the title bar, if the toolbar is floating), then drag and drop the toolbar to the desired location. If you drop the toolbar near an edge of the main window, it will be docked on that edge. If you drag the toolbar away from the window edge, it will float instead of being docked.
- To toggle between a floating toolbar and a docked toolbar, double-click on a spot between toolbar buttons (or on the title bar, if the toolbar is floating).
• To prevent the toolbar from being docked, hold down the Ctrl key as you move the toolbar.

Common Fields

Many menu commands display dialog boxes in which you can enter information and set options. This section describes dialog box common fields.

The following fields are common to many of the Constraints Editor dialog boxes.

• OK closes the dialog box and implements the intended action according to the settings in the dialog box.

• Cancel closes the dialog box without effecting any action.

• Help displays information on that particular dialog box.

Moving Items in List Boxes

Many of the dialog boxes feature list boxes. You can select and move items from one list box to another using one of four buttons.

• Add adds selected items to a target list box.

• Add All adds all items to a target list box. It is not necessary to select the items.

• Remove removes selected items from a list box

• Remove All removes all items from a list box. It is not necessary to select the items.

Using the Mouse

Use the mouse to perform the following operations.

• To select toolbar buttons, menus and menu items, and dialog box options, click the left mouse button on the desired item.

• To execute a “drag and drop” operation, place the cursor on the object you wish to move, press and hold the left mouse button as you move the cursor to the location you wish to move the object, then release the mouse button.

• To display a context-sensitive menu, move the mouse cursor over the appropriate area in the main window and then click the right
mouse button. A menu will appear displaying possible operations you can perform. Click the right mouse button on the desired operation.

**Using the Keyboard**

Use the keyboard to select objects on your screen, such as a dialog box button or a menu option.

- To choose a menu and display its options, press the Alt key and the appropriate underlined letter key corresponding to the menu you want. For example, press Alt F to select the File menu.
- Use the arrow keys to scroll down the list of options in a menu or list box. Press Enter or space bar when the option you want to use is highlighted or, in the case of a menu item, press the underlined letter corresponding to the menu option you want. For example, press the N key to select the New command of the File menu.
- To select a dialog box option, use the Tab key to position the cursor on that object and highlight it. Press Enter to process the selection.
  
  To cancel out of a dialog box without changing anything, press the Esc key.
- To move to previous fields within dialog boxes, press and hold the Shift key, then press the Tab key.
- To obtain help, press the F1 function key.

**Obtaining Online Help**

The Constraints Editor contains a Help menu. You can obtain help on commands and procedures through the Help menu or by selecting the Help toolbar button. In addition, the dialog boxes associated with many commands have a Help button that you can click to obtain context-sensitive help.

**Help Menu**

Use the following Help menu commands to obtain help.

- The Help Topics command opens Help and lists the online help topics available for the Constraints Editor. From the Help Topics
Getting Started

page, you can jump to command information or step-by-step instructions for using the software. After you open help, you can click on the Help Topics button in the Help window whenever you want to return to the help topic list.

- The About Constraints Editor command opens a popup window that displays the version number of the software and a copyright notice.

Toolbar Help Button

You can obtain context-sensitive help from the toolbar as follows.

1. Click the Help button in the toolbar.

The cursor changes to a question mark.

2. Click once with the left mouse button on the menu item or toolbar button for which you want help.

The software displays help for the selected command or option.

Note: You can also press Shift F1 to obtain context-sensitive help.

Help Button in Dialog Boxes

Many of the dialog boxes in the Constraints Editor have a Help button that you can click to obtain help for the dialog box with which you are working. You can also press Alt H on your keyboard while positioned over the dialog box to obtain help.

F1 Key

Pressing the F1 key on a dialog box displays help on that dialog box. Pressing the F1 key is the same as selecting Help Topics from the Help menu, if no dialog boxes are displayed.
Exiting the Constraints Editor

To exit, select File → Exit. A confirmation dialog box appears. If you have unsaved data, you are asked whether you want to save it. Click Yes to save the data and quit the application.
Chapter 3

Menu Commands

This chapter describes the Constraints Editor menu commands. It includes these sections.

• “File Menu”
• “View Menu”
• “Window Menu”
• “Help Menu”

File Menu

The File menu contains commands that open, close, modify, and save files.

New
Opens a new UCF (User Constraints File).

Open
Opens an existing UCF (defined above) and a corresponding NGD (Native Generic Database) file.

Close
Closes all active tab windows. The main window remains open.

Save
Saves Constraints Editor data to the UCF file with its current file name and location.

Save As
Saves the Constraints Editor data to the UCF filename and directory you specify. When you select this command, a standard file selection dialog box opens.
View Menu

The View Menu is used to display or hide the Toolbar and the Status Bar.

- Toolbar: Toggles between displaying and hiding the Toolbar.
- Status Bar: Toggles between displaying and hiding the Status Bar.

Window Menu

The Window menu is used to customize the appearance of the Constraints Editor windows.

- Constraints Window: Toggles between displaying and hiding the window that displays editable or read-only constraints.
- Output Window: Toggles between displaying and hiding the window that displays errors, warnings, and information messages.
- Global: Displays the Global tab window
- Ports: Displays the Ports tab window
- Advanced: Displays the Advanced tab window

Help Menu

The Help menu is used to access online help.

- Help Topics: Displays a list of topics for online help.
- Online Documentation: Opens software manuals on the Web. If you do not have Web access, you can still access the documentation, either from the copy you installed on your local hard drive or from the CD. The manuals are opened in the default Web browser. You can set your default browser using the Preferences command.
- About the Constraints Editor: Provides information on the current version of online help.
Chapter 4

Using the Constraints Editor

This chapter describes the actions required to execute the various functions of the Constraints Editor. It contains the following sections.

- “Loading Files”
- “Creating and Modifying Constraints”
- “Viewing Constraints”
- “Output Window”

Loading Files

Files are loaded from the Constraints Editor Main window or from the command line at invocation (see the “Starting the Constraints Editor” section in the “Getting Started” chapter for command line syntax).
Figure 4-1  Constraints Editor Main Window

1. Click **open** from the File menu on the Constraints Editor Main Window to open the Open Constraints File dialog box (shown below).
2. From the Open Constraints File dialog box, select the directory from the Look in pull-down list, then select a UCF file name from the list box. Alternately, you can type a path in the File name text box.

3. Click **Open** to open the Open Design File dialog box (shown below).
Figure 4-3  Open Design File Dialog Box

**Note:** The root name of the UCF file that you opened is displayed by default in the File name list box.

4. Click **Open**.

If the NGD file name displayed in the File name box exists, the file opens and information from that file is displayed in the Constraints Editor.

If the NGD file name does not exist, you get a message similar to the one shown below.

Select the desired NGD file name from the list displayed in the Open Design File dialog box, or enter the NGD file name in the File name text box.

5. Click **Open**.
Creating and Modifying Constraints

This section tells you how to create and modify constraints from the Global tab window, from the Ports tab window, and from the Advanced tab window.

Note: When a constraint is created or modified, it appears syntactically in the Editable Constraints window the same way it appears in the UCF (refer to the “UCF Syntax” appendix). Constraints can be modified by double-clicking on the constraint syntax in the Editable Constraints window.

The following sections explain how to create and modify constraints.

• “From the Global Tab Window”
• “From the Ports Tab Window”
• “From the Advanced Tab Window”
• “From the Constraints Window”

From the Global Tab Window

Global constraints specify timing requirements for all inputs/outputs that are clocked by the clock net you identify. Constraints created from the Ports tab window and the Advanced tab window take precedence over ones created from the Global tab window.

You can create and modify the following constraints from the Global tab window.

• “Clock Period”
• “Pad to Setup”
• “Clock to Pad”
• “Pad to Pad”

On the Global tab window, the Constraints Editor allows you to modify existing constraints directly on the grid (without opening a dialog box).

To modify a constraint directly on the grid

1. Position the cursor in the grid row and column containing the constraint and click the left mouse button.
2. Highlight the value and enter a new one.

3. Change the focus by moving the cursor to another row or column and click the left mouse button.

**Note:** To change a time unit to anything but nanoseconds, you must use a dialog box.

The following sections describe creating and modifying constraints using dialog boxes.

**Clock Period**

To define a clock period constraint, open the Global tab window (see the “Global Tab Window” figure). Follow the steps below.

1. In the Period column and in the row associated with the appropriate clock net name, double-click the left mouse button to open the Clock Period dialog box.

**Note:** An alternate way to invoke the Clock Period dialog box is to right click anywhere in the grid row containing the desired clock net name, then select `Period` from the pop-up window.
By default, a timing specification name for the clock period is displayed in the TIMESPEC Name text box. The name consists of the characters TS and an identifier in the form of the clock net name; for example, TS_CLK1_IN as shown in the figure above.

**Note:** You are allowed to change the timespec name, but the name must begin with the characters TS. The name that you selected from the Clock Net Name column is displayed in the Clock Net Name box.

2. In the Clock Signal Definition field, you must select either Specific Time or the Relative to other PERIOD TIMESPEC. Specific Time indicates an explicit time for clock period. Relative to other PERIOD TIMESPEC indicates a time that is relative to a period specified in another timespec.

If you select Specific Time, provide the following information.

---

**Figure 4-4 Clock Period Dialog Box**

By default, a timing specification name for the clock period is displayed in the TIMESPEC Name text box. The name consists of the characters TS and an identifier in the form of the clock net name; for example, TS_CLK1_IN as shown in the figure above.

**Note:** You are allowed to change the timespec name, but the name must begin with the characters TS. The name that you selected from the Clock Net Name column is displayed in the Clock Net Name box.

2. In the Clock Signal Definition field, you must select either Specific Time or the Relative to other PERIOD TIMESPEC. Specific Time indicates an explicit time for clock period. Relative to other PERIOD TIMESPEC indicates a time that is relative to a period specified in another timespec.

If you select Specific Time, provide the following information.
• Fill in a time in the Time box and select a time unit from the Units pull-down list.

• Click on either \textbf{Start HIGH} or \textbf{Start LOW}, depending on whether you want the initial clock state to be high or low.

• Fill in a time in the Time HIGH (or Time LOW) box and select a time unit from the Units pull-down list.

• If you select Relative to other PERIOD TIMESPEC, provide the following information.

• Select a reference timespec from the pull-down list.

• Click on either \textbf{Multiply by} or \textbf{Divide by} and provide a value in the Factor box.

3. Click \textbf{OK}.

**Pad to Setup**

Pad to Setup creates a constraint that allows you to specify the timing relationship between an external clock and data at the pins of a device, specifically the arrival of data \textit{before} the arrival of a clock edge. The Global tab window generates a dialog box from which you can specify a pad to setup requirement for all inputs that are clocked by the net you identify.

1. In the Pad to Setup column and in the row associated with the appropriate clock net name, double-click the left mouse button to open the Pad to Setup dialog box.

\textbf{Note}: An alternate way to invoke the Pad to Setup dialog box is to right click anywhere in the grid row containing the desired clock net name, then click \textbf{Pad to Setup} from the pop-up window.
2. Enter a value for time in the Time Requirement text box and the desired unit from the Units pull-down list.

**Note:** The Relative to Clock Pad Net field contains the name that you selected in Step 1. You are not allowed to change this field.

3. Click **OK**.

**Clock to Pad**

This constraint specifies the timing relationship between an external clock and data at the pins of a device, specifically the availability of the data after the arrival of the clock. The Global tab window generates a dialog box from which you can specify a clock to pad requirement for all output that are clocked by the clock net you identify.

1. In the Clock to Pad column and in the row associated with the appropriate clock net name, double-click the left mouse button to open the Clock to Pad dialog box.
**Note:** An alternate way to invoke the Clock to Pad dialog box is to right click anywhere in the grid row containing the desired clock net name, then click **Clock to Pad** from the pop-up window.

![Clock to Pad Dialog Box](image)

**Figure 4-6  Clock to Pad Dialog Box (From the Global Tab Window)**

2. Enter a time requirement in the Time Requirement text box and the desired unit from the Units pull-down list.

**Note:** The Relative to Clock Pad Net field contains the name that you selected in Step 1. You are not allowed to change this field.

3. Click **OK**.

**Pad to Pad**

This constraint specifies a maximum allowable time for the data to enter the chip, travel through logic and routing, and leave the chip.
Using the Constraints Editor

**Figure 4-7 Pad to Pad Dialog Box**

1. If you wish to change the default time spec name, replace "P2P" with the name of your choice. Remember that all time specs must begin with the characters TS.

2. Enter a time value in the Time text box and select the desired unit from the Units pull-down list.

3. Click OK.

**From the Ports Tab Window**

Constraints created from the Ports tab window apply only to specified ports. They override constraints created from the Global and Advanced tab windows. See the “Using Timing Constraints” chapter in the Development System Reference Guide for constraints precedence.

You can create and modify the following constraints from the Ports tab window.

- “Location”
- “Pad to Setup”
- “Clock to Pad”
- “I/O Configuration Options”
- “Prohibit I/O Locations”
- “Pad Grouping”

On the Ports tab window, the Constraints Editor allows you to modify I/O Configuration Options directly on the grid (without opening a dialog box).
To modify a constraint directly on the grid, place the cursor in the grid row and column containing the constraint, click the down arrow to open a pull-down menu and drag the cursor to your selection.

The following sections describe creating and modifying constraints using dialog boxes.

**Location**

This constraint locks a user-defined port to a specific device pin.

1. In the Location column and in the row associated with the Port Name, double-click the left mouse button to open the Location dialog box.

**Note:** An alternate way to invoke the Location dialog box is to right click anywhere in the grid row containing the desired port name, then click *Location* from the pop-up window.

![Location Dialog Box](image)

2. In the Location text box, enter a valid pin name for the part you are using.

3. Click **OK**.

**Pad to Setup**

Creating a pad to setup constraint from the Ports tab window is similar to creating one from the Global tab window, except it is for a specific port. The Ports tab window generates a dialog box with which you can specify a time requirement for individual pad nets (as opposed to the Global tab window where you are specifying *all* inputs clocked by the clock pad net you select). To create this constraint, follow the steps below.
1. In the Pad to Setup column and in the row associated with the appropriate port name, double-click the left mouse button to open the Pad to Setup dialog box.

   **Note:** An alternate way to invoke the Pad to Setup dialog box is to right click anywhere in the grid row containing the desired port name, then click **Pad to Setup** from the pop-up window.

   ![Pad to Setup Dialog Box (From Ports Tab Window)](image)

   The port name that you selected from the Ports tab window appears in the Pad Net box.

2. Enter a time requirement in the Time Requirement text box and the desired unit from the Units pull-down list.

3. Select the clock that clocks this input from the Relative to Clock Net pull-down list.

   **Note:** If you fail to specify the correct clock, NGDBuild (translation) will error out.

4. Click **OK**.

**Clock to Pad**

Creating a clock to pad constraint from the Ports tab window is similar to creating one from the Global tab window, except it is for a specific port. The Ports tab window generates a dialog box with which you can specify a time requirement for individual pad nets (as
opposed to the Global tab window where you are specifying all output clocked by the clock pad net you select). To create this constraint, follow the steps below.

1. In the Clock to Pad column and in the row associated with the appropriate port name, double-click the left mouse button to open the Clock to Pad dialog box.

![Clock to Pad Dialog Box (From Ports Tab Window)](image)

### Note:
An alternate way to invoke the Clock to Pad dialog box is to right click anywhere in the grid row containing the desired port name, then click **Clock to Pad** from the pop-up window.

2. Enter a time requirement in the Time Requirement text box and the desired unit from the Units pull-down list.

3. Select the clock that clocks this input from the Relative to Clock Net pull-down list.

### Note: In the next step, if you fail to specify the correct clock, NGDBuild (translation) will error out.

4. Click **OK**.

### I/O Configuration Options

Clicking the I/O Configuration Options box adds a number of columns to the grid on the Ports tab window. There are two ways to create I/O configuration constraints. The procedures are the same for all options.
• Place the cursor anywhere in the row associated with the port name and click the right mouse button. In the pop-up window, rest the cursor on the desired option name, then make your selection from the sub-menu.

• Click the left mouse button in any option column (options are listed below). Click the down arrow and make your selection from the sub-menu.

**FAST/SLOW** This option determines the output slew rate (transition time) for output and bidirectional I/O signals. A fast slew rate has a quicker transition time and a slow rate a longer one. Limiting the slew rate reduces output switching surges in a device.

**PULLUP/PULLDOWN** This option places a pullup or pulldown resistor on the selected port. KEEPER, an option for Virtex devices only, keeps the input level of tri-state buffers on a pad net. For example, if a logic 1 is driven onto the net and the net driver is tri-stated, KEEPER drives a week/resistive 1 onto the pad net.

**DRIVE** This option determines signal strength in milli-amps.

**IOSTANDARD** (Virtex devices only) This option specifies an input/output standard; for example, low voltage TTL (LVTTL), low voltage CMOS (LVCMOS2), and so forth.

### Prohibit I/O Locations

This constraint disallows the use of an I/O site by PAR (Place and Route) and FPGA Editor.

1. Click **Prohibit I/O Locations** to open the Prohibit I/O Locations dialog box.
2. In the I/O Locations text box enter a valid pin name for the part you are using.

3. Click **Add** to add the pin name to the Prohibit I/O Locations box.

4. Click **OK**.

**Pad Grouping**

This field enables you to create pad groups, allowing you to apply a constraint to the group rather than applying it separately to a number of pads.
Using the Constraints Editor

Figure 4-12 Pad Groups Field on Ports Tab Window

1. Select the members of the pad group from the Port Name column on the grid.
2. Type the name of the group in the Pad Groups box.
3. Click Create Group.
4. To select a pad group, click on the group name in the box next to the Select Group button, then click Select Group.

From the Advanced Tab Window

Constraints created from the Advanced window take precedence over ones created from the Global window. When there is contention between the Ports window and the Advanced window, the constraint created from the Ports tab window takes precedence.

You can create and modify the following constraints from the Advanced tab window.

- “Group Elements Associated by Nets (TNM_NET)”
- “Group Elements by Instance Name (TNM)”
- “Group Elements by Element Output Net Name, Schematic Users (TIMEGRP)”
- “Timing THRU Points (TPTHRU)”
- “Pad to Setup Requirement(s) for Groups of Pads and/or Registers (OFFSET IN BEFORE)”
- “Clock to Pad Requirement(s) for Groups of Pads and/or Registers (OFFSET OUT AFTER)”
Group Elements Associated by Nets (TNM_NET)

A Time Name (TNM_Net) is an attribute used to identify elements that compose a group. This group can be used in a timing specification. A Time Name can be created using elements associated by nets (All Nets, Clock Nets, and Clock Enable Nets). If you use Clock Nets, all valid elements fed by all paths that fan forward from the net belong to the group. Forward tracing stops at any RAM, PAD, FF, or LATCH.

1. Click **Create** next to "Group elements associated by Nets (TNM_NET)" to open the Time Name dialog box.
2. In the Time Name text box, enter the new time name. The name can consist of any combination of letters, numbers, or underscores. Keep the name short for convenience and clarity.

3. Make a selection from the Design Element Type pull-down list.

4. (Optional) If you want to limit the number of selections in the Available box, use the Filter text box. For example, if you want as your time name targets only nets containing the string “counter,” type `counter` in the Filter box. Names are not case-sensitive. (See the above figure).

5. In the Available list box, click on the net names that you want in the time name targets.

6. To move a selected element from the Available list into the Time Name Targets list, click Add (or to add all elements, Add All). Click Remove to remove an element from the Time Name Targets list (or Remove All to remove all elements).
Group Elements by Instance Name (TNM)

This constraint creates groups consisting of instance names of an element. Elements are FFs, Pads, RAMs, and Latches.

1. Click **Create** next to "Group elements by instance name (TNM)" to open the Time Name dialog box (see the “Time Group Dialog Box” figure).

2. Enter a name in the Time Name text box. The name can consist of any combination of letters, numbers, or underscores. Keep the name short for convenience and clarity.

3. Select a design element from the Design Element Type pull-down list.

4. (Optional) If you want to limit the number of selections in the Available box, use the Filter text box. For example, if you want as your time name targets only input pads containing the string "test " type `test` in the Filter box. Names are not case-sensitive. See the “Time Name Dialog Box” figure as an example.

5. From the Available list, select the instance names for the group.

6. To move a selected element from the Available list into the Time Name Targets list, click **Add** (or to add all elements, **Add All**).

7. When you have completed your selections, click **OK**.

Group Elements by Element Output Net Name, Schematic Users (TIMEGRP)

Time groups are common elements to which a timing constraint applies. This time group is made up of an element's output net names. Elements are FFs, Pads, Input, Output, Bi-directional, Tri-stated, RAMs, or Latches.

**Note:** This constraint applies only to schematic entry designs.

1. Click **Create** next to "Group elements by element output net name, schematic users (TIMEGRP)" to open the Time Group dialog box.
2. In the Time Group Name text box, enter a name for the timing group. The name can consist of any combination of letters, numbers, or underscores. Keep the name short for convenience and clarity.

3. Make a selection from the Design Element Type pull-down list.

4. (Optional) If you want to limit the number of selections in the Available box, use the Filter text box. For example, if you want as your time name targets only pads containing the string "ce_test," type ce_test in the Filter box. Names are not case-sensitive. See the above figure as an example.

5. In the Available pull-down list, click on the output net names that you wish to be members of the time group.

6. To move a selected element from the Available list into the Time Name Targets list, click Add (or to add all elements, Add All). Click Remove to remove an element from the Time Name Targets list (or to remove all elements, Remove.)
7. After you have placed all of the desired members in the Time Group Members list, click **OK**.

**Timing THRU Points (TPTHRU)**

This constraint applies when it is convenient to define intermediate points on a path to which a specification applies. TPTHRU identifies the intermediate point(s).

1. Click **Create** next to "Timing THRU Points (TPTHRU) to open the Timing THRU Point dialog box.

![Timing THRU Point Dialog Box](image)

2. Enter a name in the TPTHRU Name text box. The name can consist of any combination of letters, numbers, or underscores. Keep the name short for convenience and clarity.

```plaintext
Figure 4-15 Timing THRU Point Dialog Box
```
3. Select **All Nets** or **TBUFs** from the Design Element Type pull-down list.

4. (Optional) If you want to limit the number of selections in the Available box, use the Filter text box. For example, if you want as your TPTHRU target members only nets containing the string "clk," type `clk` in the Filter box. Names are not case-sensitive. See the above figure as an example.

5. In the Available list box, select the names of the nets or TBUFs that will identify the intermediate points on your path.

6. To move a selected element from the Available list into the TPTHRU Targets list, click **Add** (or to add all elements, **Add All**).

7. When you have completed your selections, click **OK**.

**Pad to Setup Requirement(s) for Groups of Pads and/or Registers (OFFSET IN BEFORE)**

Creating a pad to setup constraint from the Advanced tab window is similar to creating one from the Global or Ports tab windows. The major difference is that with the Advanced tab window you are dealing with **groups** of pads or registers.

The Advanced tab window opens a dialog box from which you can specify a pad group, register time group (or both), and a time requirement relative to a specified clock net. The register time group allows you to limit the paths.

To create a pad to setup constraint from the Advanced tab window, follow the steps below.

1. Click **Specify** next to "Pad to Setup Requirement(s) for Groups of Pads and/or Registers (OFFSET IN BEFORE)" to open the Pad to Setup dialog box.
2. Select a pad group from the Pad Group list.

3. Enter a time requirement in the Time Requirement text box and the desired unit from the Units pull-down list.

4. Select the clock that clocks this input from the Relative to Clock Pad Net pull-down list.

5. (Optional) Select a register timegroup from the Register Timegroup pull-down window. Make sure that this window is clear if you don’t want a register timegroup.

6. Click OK.

**Clock to Pad Requirement(s) for Groups of Pads and/or Registers (OFFSET OUT AFTER)**

Creating a clock to pad constraint from the Advanced tab window is similar to creating one from the Global or Ports tab windows. The major difference is that with the Advanced tab window you are dealing with groups of pads or registers.
Using the Constraints Editor

The Advanced tab window opens a dialog box from which you can specify a pad group, register time group (or both) and a time requirement relative to a specified clock net. The register time group allows you to limit the paths.

To create a clock to pad constraint from the Advanced tab window, follow the steps below.

1. Click Specify next to "Clock to Pad Requirement(s) for Groups of Pads and/or Registers (OFFSET OUT AFTER)" to open the Clock to Pad dialog box.

![Clock to Pad Dialog Box](From Advanced Tab Window)

2. Select a pad group from the Pad Group pull-down list. (Pad Group identifies a predefined group of pads.)

3. Enter a time requirement in the Time Requirement text box and the desired unit from the pull-down list.

4. Select the clock that clocks this input from the Relative to Clock Net pull-down list.
5. (Optional) Select a register timegroup from the Register Time-
group pull-down window. Make sure that this window is clear if 
you don’t want a register timegroup.

6. Click OK.

**Slow/Fast Path Exceptions (FROM TO)**

This generates the FROM/THRU/TO dialog box, which allows you
to specify an explicit maximum delay between groups of elements 
and through intermediate points.

1. Click **Specify** next to "Slow/Fast Path Exceptions (FROM TO)"
to open the FROM/THRU/TO dialog box.
Using the Constraints Editor

2. In the Time Spec Name text box enter a time specification name. The name should be entered in the form TS_id, where id is a
unique name. The name can consist of letters, numbers, and the underscore character (_), but it must be preceded by the letters TS.

3. In the Groups field, make a selection from the From Group and To Group pull-down lists.

4. If applicable, make a selection from the THRU Points list.

5. Enter a value for time in the Time text box and select the appropriate unit from the Units pull-down list. No other entries for this constraint are required on this dialog box.

6. Click OK.

**Multicycle Paths (FROM TO)**

This constraint allows you to specify a maximum delay (between groups of elements and through intermediate points) that is relative to another timing specification.

1. Click Specify next to "Multicycle Paths (FROM TO)" to open the FROM/THRU/TO dialog box.
Using the Constraints Editor

Figure 4-19  FROM/THRU/TO Dialog Box
2. In the Time Spec Name text box enter a time specification name. The name should be entered in the form TSid, where id is a unique name. The name can consist of letters, numbers, and the underscore character (_) but it must be preceded by the letters TS.

3. In the Groups field, make a selection from the From Group and To Group pull-down lists.

4. If applicable, make a selection from the THRU Points (optional) list.

5. Select a reference time specification from the Reference TIMESPEC pull-down list.

6. Click Multiply by or Divide by.

7. Enter a value in the Factor text box.

8. Click OK.

**False Paths (FROM TO TIG)**

This constraint allows you to specify paths between groups (and intermediate points between those groups) as ones that will be ignored by timing.

1. Click Specify next to "False Paths (FROM TO TIG)" to open the FROM/THRU/TO dialog box.
Figure 4-20  FROM/THRU/TO Dialog Box
2. In the Time Spec Name text box enter a time specification name. The name should be entered in the form TS\textit{id}, where \textit{id} is a unique name. The name can consist of letters, numbers, and the underscore character but it must be preceded by the letters TS.

3. In the Groups field, make a selection from the From Group and To Group pull-down lists.

4. If applicable, make a selection from the THRU Points (optional) list.

5. Click **OK**.

**False Paths by Nets (NET TIG)**

This constraint allows you to mark nets used in timing specifications as ones that will be ignored by timing. To create this constraint, follow the steps below.

1. Click **Specify** next to "False Paths by Nets (Net TIG)" to open the Timing Ignore dialog box.
Using the Constraints Editor

Figure 4-21  Timing Ignore Dialog Box

2. From the Net pull-down list, select the name of the net that you wish to be ignored for timing purposes.

3. From the TIMESPECs Available pull-down list, select the desired timespecs that contain the net you selected in step 2. If you do not select a timespec, the constraint will apply to all the applicable timespecs in the list.

4. Click Add to add a selected time spec to the Ignored TIMESPECs box.

5. Click OK.
Prorating Voltage

This is the operating voltage for the chip. Voltage ranges vary from device to device.

![Voltage Dialog Box](image-url)

**Figure 4-22 Voltage Dialog Box**

**Note:** Prorating is not supported for all families and is not intended for military or industrial use. The supported ranges are commercial ranges only.

1. Click **Specify** next to "Voltage."
2. Enter a value for your device.

**Note:** If you specify a voltage that is out of range for the part, you will receive a message giving you the acceptable range.

Prorating Temperature

This is the junction temperature for the device. This varies from device to device.

![Temperature Dialog Box](image-url)

**Figure 4-23 Temperature Dialog Box**
**Note:** Prorating is not supported for all families and is not intended for military or industrial use. The supported ranges are commercial ranges only. Click **Specify** next to "Temperature."

Enter a value in the Celsius text box and click **OK**.

**Note:** If you specify a temperature that is out of range for the part, you will receive a message giving you the acceptable range.

**From the Constraints Window**

You can open a dialog box to modify a constraint by double clicking on the constraint syntax that appears in the Editable Constraints window. See the “Constraints Window and Output Window” figure.

**Viewing Constraints**

Editable and Source (read-only) constraints can be viewed in the Constraints window. By default, the Constraints window opens in the bottom half of the main window when you open an NGD file.

![Constraints Window and Output Window](image)

**Figure 4-24  Constraints Window and Output Window**

To view editable constraints as they appear in the UCF, click the **Editable Constraints** button. To look at read-only constraints, click the **Source Constraints** (read-only) button.

You can alter the way the Constraints window is displayed to suit your needs. Please refer to the “Constraints Window” section in the Windows and Dialog Boxes chapter.
Output Window

The Output window is located in the bottom half of the Main window directly below the Constraints window. It displays errors, warnings, or information messages.

The tabs at the bottom of the window determine what type of information is displayed.
Chapter 5

Windows and Dialog Boxes

This chapter describes the Constraints Editor windows and dialog boxes and their functions. It includes these sections.

- “Main Window”
- “Global Tab Window”
- “Ports Tab Window”
- “Advanced Tab Window”
- “Constraints Dialog Boxes”
- “Constraints Window”
- “Output Window”

In the Constraints Editor, dialog boxes are used to create and modify constraints. You can open dialog boxes in the following ways.

- From the Global and Ports tab windows, double-click in the appropriate grid row and column. For example, if you want to create or change a Pad to Setup Constraint for CLK1_IN, double-click in the row containing CLK1_IN under the Pad to Setup column (refer to the figure below).
From the Global and Ports tab windows, place the cursor in a row associated with a clock and click the right mouse button. This opens a pop-up menu like the one shown here.

* Select a constraint from the pop-up window to open the dialog box that will be used to specify the constraint’s parameters.

* From the Advanced tab window, click on the button associated with the constraint.

**Main Window**

The Main Window appears first when you open the Constraints Editor. The Main window contains the menu bar, toolbar, status bar, Constraints window, and Output window. When you open an NGD file, the Global tab window, the Constraints window, and the Output window all open by default. The Global tab window displays in the top half of the Main window; the Constraints window and Output window display in the bottom half.
The Global tab window is the first window to appear when you load a file. It is used to specify clock periods, pad to setup, clock to pad, and pad to pad constraints. To open the Global tab window, click the Global tab on the main window.

To close the window, click the Ports or Advanced tab.
Figure 5-2  Global Tab Window

Field                        Description
Clock Net Name               Lists all of the root clock nets for the design. Root clock nets are nets that clock synchronous elements. The name presented is the name at which the clock is derived, such as a pad, a gate, or a flip-flop.
Period                       Specifies a period for a clock. See “Clock Period” in the "Using the Constraints Editor" chapter.
When you create a constraint from the Ports tab window, the constraint is applied to a specified port. Any constraint created from the Ports tab window overrides a contending constraint created from the Global tab window.

Constraints created from the Ports tab window are used to do the following.

- Lock a user-defined port to a device package pin
- Set specific Pad to Setup and Clock to Pad constraints for an individual port
- Specify output slew rate
- Prohibit the use of I/O locations by the implementation tools.
- Pullup, pulldown, or keep the input level on a pad net with a tristate buffer.
- Specify an I/O Standard (Virtex devices only)
- Specify a drive strength (in mA) for output ports

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pad to Setup</td>
<td>The time allowed for data to propagate from the input to meet the setup requirement at the synchronous element. This is a global constraint for all input ports per clock.</td>
</tr>
<tr>
<td>Clock to Pad</td>
<td>This is the value representing the clock delay, the clock-to-out of a synchronous element plus propagation time to the pad. This is a global constraint for all output ports per clock. Using the Clock to Pad constraint under the Ports tab can override the global constraint with a specified value for the selected port. See “Clock to Pad” in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Pad to Pad</td>
<td>A value representing the maximum allowable propagation delay from an input pin of the device through combinatorial logic to an output pin of the device. See “Pad to Pad” in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
</tbody>
</table>

### Ports Tab Window

When you create a constraint from the Ports tab window, the constraint is applied to a specified port. Any constraint created from the Ports tab window overrides a contending constraint created from the Global tab window.

Constraints created from the Ports tab window are used to do the following.

- Lock a user-defined port to a device package pin
- Set specific Pad to Setup and Clock to Pad constraints for an individual port
- Specify output slew rate
- Prohibit the use of I/O locations by the implementation tools.
- Pullup, pulldown, or keep the input level on a pad net with a tristate buffer.
- Specify an I/O Standard (Virtex devices only)
- Specify a drive strength (in mA) for output ports
• Group pads

To open the Ports tab window, click the Ports tab on the main window.

To close the window, click the Global or Advanced tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Name</td>
<td>Identifies the port as defined by the user.</td>
</tr>
<tr>
<td>Port Direction</td>
<td>Identifies the direction of the port as input, output, or bidir (input/output).</td>
</tr>
</tbody>
</table>

![Figure 5-3 Ports Tab Window](image-url)
### Advanced Tab Window

The Advanced tab window contains three major fields, each of which contains a number of buttons for opening different dialog boxes. The Grouping field is used for creating and modifying group constraints and timing THRU points. The Timing Constraints field is used for creating and modifying timing constraints for groups of elements. The Prorating Constraints field is used for specifying environmental operating conditions for a device.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Specifies a pin location on the package.</td>
</tr>
<tr>
<td>Pad to Setup</td>
<td>Specifies a value representing the clock delay and the time allowed for data to propagate from the input to meet the setup requirement at the synchronous element plus the clock delay. The value here will override any value specified for the selected port in the Global tab window. See “Pad to Setup” in the “Using the Constraints Editor” chapter.</td>
</tr>
<tr>
<td>Clock to Pad</td>
<td>Specifies a value representing the clock-to-out of the synchronous element plus the propagation time to the pad and the clock delay. The value here will override any value specified for the selected port in the Global tab window. See “Clock to Pad” in the “Using the Constraints Editor” chapter.</td>
</tr>
<tr>
<td>I/O Configuration Options</td>
<td>When this box displays a check mark (√), a number of columns (depending on the target device) are added to the grid in the Ports tab window, such as FAST/SLOW in the above figure. Click the box to toggle the column configuration. See the “I/O Configuration Options” section in the Using the Constraints Editor chapter.</td>
</tr>
<tr>
<td>Prohibit I/O Locations</td>
<td>Disallows the use of I/O sites within PAR (Place and Route) and FPGA Editor. See “Prohibit I/O Locations” in the “Using the Constraints Editor” chapter.</td>
</tr>
</tbody>
</table>
Constraints created from the Advanced tab window take precedence over ones entered from the Global tab window. Between the Ports tab window and the Advanced tab window, the constraint entered last takes precedence.

The Advanced tab window is used to open dialog boxes for creating and manipulating constraints.

To open the Advanced tab window, click the Advanced tab on the main window.

To close the window, click the Global or Ports tab.

Figure 5-4  Advanced Tab Window
### Windows and Dialog Boxes

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Group elements associated by Nets (TNM_NET)</td>
<td>Opens a dialog box for creating a time group composed of elements by nets (All Nets, Clock Nets, and Clock Enable Nets). See the “Group Elements Associated by Nets (TNM_NET)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Create Group elements by instance name (TNM)</td>
<td>Opens a dialog box from which you can create a new time name. See the “Group Elements by Instance Name (TNM)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Create Group elements by element output net name, schematic users (TIMEGRP)</td>
<td>Opens a dialog box from which you can create a time group composed of elements by output net name. See the “Group Elements by Element Output Net Name, Schematic Users (TIMEGRP)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Create Timing THRU Points (TPTHRU)</td>
<td>Opens a dialog box from which you can create a new TPTHRU constraint. See the “Timing THRU Points (TPTHRU)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Specify Pad to Setup Requirement(s) (OFFSET IN BEFORE)</td>
<td>Opens a dialog box from which you can create a Pad to Setup constraint. See the “Pad to Setup Requirement(s) for Groups of Pads and/or Registers (OFFSET IN BEFORE)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
<tr>
<td>Specify Clock to Pad Requirement(s) (OFFSET OUT AFTER)</td>
<td>Opens a dialog box from which you can create a Clock to Pad constraint. See the “Clock to Pad Requirement(s) for Groups of Pads and/or Registers (OFFSET OUT AFTER)” section in the &quot;Using the Constraints Editor&quot; chapter.</td>
</tr>
</tbody>
</table>
This section describes the dialog boxes that are used to create and modify constraints.

- Clock Period Dialog Box
- Pad to Setup Dialog Box
- Clock to Pad Dialog Box
- Pad to Pad Dialog Box
Windows and Dialog Boxes

- Location Dialog Box
- Prohibit I/O Locations Dialog Box
- Time Name Dialog Box
- Time Group Dialog Box
- Timing THRU Point (TPTHRU) Dialog Box
- FROM/THRU/TO Dialog Box
- Timing Ignore Dialog Box
- “Voltage Dialog Box”
- “Temperature Dialog Box”

**Clock Period Dialog Box**

The Clock Period dialog box enables you to create a global clock period constraint.
Figure 5-5   Clock Period Dialog Box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMESPEC Name</td>
<td>A text box used to enter the name of the time spec for the period. The name should be entered in the form TSid, where id is a unique name. The name can consist of letters, numbers, or the underscore character (_).</td>
</tr>
<tr>
<td>Clock Net Name</td>
<td>By default, this field is filled in with the name of the clock you selected on the Global tab grid.</td>
</tr>
</tbody>
</table>
Windows and Dialog Boxes

The Pad to Setup dialog box allows you to enter a Pad to Setup constraint.

**Note:** The appearance of the Pad to Setup dialog box varies slightly depending on which tab window you use to open the box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specific Time</td>
<td>A button used to indicate that the specified clock period is to be explicitly defined by the user; that is, not relatively defined by another time spec.</td>
</tr>
<tr>
<td>Time</td>
<td>A text box used to enter a value which represents the duration of the clock period.</td>
</tr>
<tr>
<td>Units</td>
<td>A pull-down list used to select a unit of time. The default is %, which is the percentage of the period that the clock is high or low.</td>
</tr>
<tr>
<td>Start High/Start Low</td>
<td>Buttons used to specify that the initial pulse for the clock period is to be in a high or low state.</td>
</tr>
<tr>
<td>Time HIGH/LOW</td>
<td>A text used to enter the duration of the high (or low) state for the clock period.</td>
</tr>
<tr>
<td>Units</td>
<td>A pull-down list used to select a unit of time.</td>
</tr>
<tr>
<td>Relative to other PERIOD-TIMESPEC</td>
<td>A button used to specify that the clock period is to be relative to another clock period specification.</td>
</tr>
<tr>
<td>Reference TIMESPEC</td>
<td>A pull-down list used to select the name of the time spec relative to the clock period.</td>
</tr>
<tr>
<td>Multiply by/Divide by Factor</td>
<td>Buttons and a text box used to specify the factor of multiplication or division to be applied to the relative clock period.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
**Pad Net** | This field appears only if you opened the Pad to Setup dialog box from the Ports tab window. Select this if your constraint applies only to a specific pad net, then select the name of the pad net from the pull-down list.

**Pad Group** | This field appears only if you opened the Pad to Setup dialog box from the Advanced tab window. Select this if your constraint applies to a group of pads, then select the name of the group from the pull-down list.

**Time Requirement** | A text box used to enter the amount of time that data must arrive at the edge of a device before the next clock arrives at the edge of the device.
The Clock to Pad dialog box allows you to enter a Clock to Pad constraint.

**Note:** The appearance of the Clock to Pad dialog box varies slightly depending upon which tab window you use to open the box.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>A pull-down list used to select a unit of time.</td>
</tr>
<tr>
<td>Relative to Clock Pad Net</td>
<td>The clock net driving the synchronous elements. This must be correctly selected to prevent invalid constraints.</td>
</tr>
<tr>
<td>Register Timegroup</td>
<td>A user-defined register timegroup. This field applies only if you opened the Pad to Setup dialog box from the Advanced tab window.</td>
</tr>
</tbody>
</table>

### Clock to Pad Dialog Box

The Clock to Pad dialog box allows you to enter a Clock to Pad constraint.

**Note:** The appearance of the Clock to Pad dialog box varies slightly depending upon which tab window you use to open the box.

![Clock to Pad Dialog Box](image)
### Pad to Pad Dialog Box

The Pad to Pad dialog box allows you to specify a maximum time for the data to enter the chip, travel through combinatorial logic and routing, and leave the chip.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pad Net</td>
<td>This field personally if you opened the Clock to Pad dialog box from the Ports tab window. Select this if your constraint applies only to a specific pad net, then select the name of the pad net from the pull-down list.</td>
</tr>
<tr>
<td>Pad Group</td>
<td>This field appears only if you opened the Clock to Pad dialog box from the Advanced tab window. Select this if your constraint applies to a group of pads, then select the pad group name from the pull-down list.</td>
</tr>
<tr>
<td>Time Requirement</td>
<td>A text box used to specify the amount of time that data must leave the edge of a device after the current clock edge arrives at the edge of the device.</td>
</tr>
<tr>
<td>Units</td>
<td>A pull-down list used to select a unit of time.</td>
</tr>
<tr>
<td>Relative to Clock Pad Net</td>
<td>A pull-down list used to specify the clock net driving the synchronous elements. This must be correctly selected to prevent invalid constraints.</td>
</tr>
<tr>
<td>Register TimeGroup</td>
<td>A pull-down list used to specify a user-defined register timegroup. This field applies only if you opened the Clock to Pad dialog box from the Advanced tab window.</td>
</tr>
</tbody>
</table>
This dialog box allows you to lock a user-defined port to a device pin.

Field Description

Time Spec Name
A text box used to display the default name of the time spec (TS_P2P). You may change the name if you like, but all timing specification names must begin with the characters TS.

Time
A text box used to enter a pad to pad maximum delay value.

Units
A pull-down list used to select a unit of time.

Location Dialog Box

This dialog box allows you to lock a user-defined port to a device pin.
Prohibit I/O Locations Dialog Box

This dialog box allows you to prohibit the use of an I/O site by PAR and FPGA Editor.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>A text box used to enter the pin name of the port you wish to lock.</td>
</tr>
</tbody>
</table>

Figure 5-10  Prohibit I/O Locations Dialog Box
**Time Name Dialog Box**

This dialog box enables you to create a new time name based on either of group of elements by nets or by instance name. A time name (TNM) is an attribute that can be used to identify the elements that make up a group, which can then be used in a timing specification.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O Location</strong></td>
<td>A text box used to enter the pin name of the location you wish to disallow.</td>
</tr>
<tr>
<td><strong>Add Configuration Pins</strong></td>
<td>A button used to place the names of configuration pins for a device into the Prohibit I/O Locations box. Configuration pins are used to load design-specific programming data into one or more logic blocks to define the functional operation of a device’s internal blocks and interconnections.</td>
</tr>
<tr>
<td><strong>Prohibit I/O Locations</strong></td>
<td>A list box used to display prohibited locations.</td>
</tr>
</tbody>
</table>
Figure 5-11  Time Name Dialog Box
The functions of the dialog box are described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Name</td>
<td>A text box used to enter a name for the new group.</td>
</tr>
<tr>
<td>Design Element</td>
<td>A pull-down list used to display either a list of nets or a list of elements, depending on which button you used on the tab window to open the box. If you are creating a group of elements associated by nets, the list includes Clock Nets, All Nets, or Clock Enable Nets. If you are creating a group of elements by instance name, the list shows FFs, Pads, Input Pads, Output Pads, Bi-directional Pads, Tri-stated Pads, RAMs, and Latches.</td>
</tr>
<tr>
<td>Filter</td>
<td>A text box used to limit the list of available elements. Entries may consist of any string. For example, if you wanted to list only nets containing the string &quot;test,&quot; you would type test in the Filter box. Names are not case-sensitive.</td>
</tr>
<tr>
<td>Available</td>
<td>A box used to display either the net names under the net group you selected or the instance names of the element you selected from the Design Element Type pull-down list.</td>
</tr>
<tr>
<td>Time Name Targets</td>
<td>A list used to identify elements selected from the Available window. The names on this list constitute the new time group.</td>
</tr>
</tbody>
</table>

**Time Group Dialog Box**

This dialog box enables you to create a new group according to the element output net name.
The functions of the dialog box are described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Group Name</td>
<td>A text box used to enter the name of the new time group.</td>
</tr>
<tr>
<td>Design Element Type</td>
<td>A Pull-down list used to display names of design element types. The list includes FFs, All Pads, Input Pads, Output Pads, Bi-directional Pads, Tristated Output Pads, RAMs, Latches, and User Groups.</td>
</tr>
</tbody>
</table>
### Field Description

**Filter**
A text box used to limit the list of available elements. An entry in this box may consist of any string. For example, if you wanted to list only pad names containing the string "CE_TEST," you would type `ce_test` in the Filter box. Names are not case-sensitive.

**Name Available**
A box used to display all of the instance names of the available design element type selected from the Design Element Type pull-down list. **Name** is the selected element type.

**Time Group Members**
A list used to identify elements selected from the **Name Available** window. The names displayed on this list constitute the new time group.

### Timing THRU Point (TPTHRU) Dialog Box

The Timing THRU Point (TPTHRU) dialog box allows you to specify an intermediate point in a path.
Constraints Editor Guide

Figure 5-13 Timing THRU Point Dialog Box

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TPTHRU Name</td>
<td>A text box used to enter a unique name for the constraint.</td>
</tr>
<tr>
<td>Design Element Type</td>
<td>A pull-down list used to show the design element types. Choose between All Nets and TBUFs.</td>
</tr>
</tbody>
</table>
The FROM/THRU/TO dialog box allows you to stipulate a maximum allowable time delay between groups of elements through specified intermediate points and to specify paths that will be ignored by timing.
Figure 5-14 FROM/THRU/TO Dialog Box
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Spec Name</td>
<td>A text box for used to enter the name of the time spec in the form <code>T Sidd</code>, where <code>id</code> is a unique name. The name can consist of letters, numbers, or the underscore character (<code>_</code>), but it must begin with the letters <code>TS</code>.</td>
</tr>
<tr>
<td>From Group</td>
<td>A pull-down list used to select the source group to which the constraint applies.</td>
</tr>
<tr>
<td>To Group</td>
<td>A pull-down list used to select the destination group to which the constraint applies.</td>
</tr>
<tr>
<td>THRU Points (Optional)</td>
<td>A list box used to show the intermediate points that have been defined with the Constraints Editor Timing THRU Point dialog box.</td>
</tr>
<tr>
<td>Explicit</td>
<td>A button used to indicate that the time spec is explicit; that is, non-relative to any other time spec. This is the default configuration for the Slow/Fast Path Exceptions constraint.</td>
</tr>
<tr>
<td>Time</td>
<td>A text box used to enter the maximum allowable delay between the source group and the destination group.</td>
</tr>
<tr>
<td>Units</td>
<td>A pull-down list used to enter a unit of time.</td>
</tr>
<tr>
<td>Relative to other path specification</td>
<td>A button used to identify the new time spec as one that is relative to another time spec. This is the default configuration for the Multicycle Paths constraint.</td>
</tr>
<tr>
<td>Reference TIMESPEC</td>
<td>The name of the time spec referenced if you identified the time spec name as relative.</td>
</tr>
</tbody>
</table>
The Timing Ignore dialog box allows you select timing specifications that contain a net that you want timing to ignore.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiply by/Divide by</td>
<td>Buttons used to select the mathematical operation between the new time spec and the relative time spec.</td>
</tr>
<tr>
<td>Factor</td>
<td>A text box used to enter a value for the multiplication or division factor.</td>
</tr>
<tr>
<td>Mark as false paths</td>
<td>A button used to specify that the selected groups and timing points will be ignored by timing. This is the default configuration for False Paths (FROM TO TIG).</td>
</tr>
</tbody>
</table>

**Timing Ignore Dialog Box**

The Timing Ignore dialog box allows you select timing specifications that contain a net that you want timing to ignore.
**Field** | **Description**  
--- | ---  
Net | A pull-down list used to select the name of the net that you wish to be ignored by timing.
Constraints Editor Guide

Voltage Dialog Box

The Voltage dialog box allows you to specify a non worst case operating voltage. This provides a means of prorating delay characteristics based on the voltage you specify.

The prorating voltage range differs by family.

![Voltage Dialog Box](image)

**Figure 5-16 Voltage Dialog Box**

The text box is for entering a value for voltage. The value may be an integer or whole number and varies for different devices.

Temperature Dialog Box

The Temperature dialog box allows you to specify a non worst case operating temperature, which provides a means of prorating device delay characteristics based on the specified junction temperature.

Each architecture has its own specific range of valid operating temperatures.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMESPECs Available</td>
<td>A list box used to show the available time specifications containing the selected net. If you do not select any time specs, the constraint will apply to all of the time specs displayed in this list.</td>
</tr>
<tr>
<td>Ignored TIMESPECs</td>
<td>A list box used to display the specs selected from the TIMESPECs Available list.</td>
</tr>
</tbody>
</table>
The Constraints window opens in the bottom half of the Main window when you open an NGD file. You can view either editable or read-only constraints, which are selectable from the two tabs at the bottom of the window.

Clicking the right mouse button anywhere within the window opens a pop-up menu from which you can manipulate editable constraints and control the way the window is displayed.
Constraints Editor Guide

The Output window is located in the bottom half of the Main window directly below the Constraints window. It displays errors, warnings, or other information, depending on the tab selected at the bottom of the window (see the “Constraints Window and Output Window” figure).

By default, the Output window, like the Constraints window, opens when you start the Constraints Editor, but it does not display information until you open a UCF/NGD file.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Docking</td>
<td>Enables you to move and park the window anywhere on the screen.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides the window. To display the window after hiding it, click Constraints Window on the Window menu.</td>
</tr>
<tr>
<td>Disable</td>
<td>Toggles between commenting out and uncommenting a selected editable constraint.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes a constraint from the UCF.</td>
</tr>
</tbody>
</table>
Appendix A

UCF Syntax

This appendix describes the UCF syntax for constraints created with the Constraints Editor. It contains the following sections.

• “Group Elements Associated by Nets (TNM_Net)”
• “Group Elements by Instance Name (TNM)”
• “Group Elements by Element Output Net Name Schematic Users (TIMEGRP)”
• “Timing THRU Points (TPTHRU)”
• “Pad to Setup”
• “Clock to Pad”
• “Slow/Fast Path Exceptions (FROM TO)”
• “Multicycle Paths (FROM TO)”
• “False Paths (FROM TO TIG)”
• “False Paths by Net (Net TIG)”
• “Period”
• “Location”
• “Prohibit I/O Locations”
• “FAST/SLOW”
• “PULLUP/PULLDOWN”
• “DRIVE”
• “IOSTANDARD (Virtex devices only)”
• “VOLTAGE”
• “TEMPERATURE”
Group Elements Associated by Nets (TNM_Net)

Definition
Identifies the nets that make up a group which can then be used in a timing specification. A TNM_NET (timing name for nets) is an attribute that can be used to identify the elements that make up a group which can then be used in a timing specification. Essentially TNM_NET is equivalent to TNM on a net *except* for pad nets.

UCF Syntax

```
NET netname TNM_Net=identifier;
```

*netname* is the name of a net. *identifier* is a value that consists of any combination of letters, numbers, or underscores.

Group Elements by Instance Name (TNM)

Definition
Identifies the instances that make up a group which can then be used in a timing specification. A TNM (pronounced tee-name) is a flag that you place directly on your schematic to tag a specific net, element pin, primitive or macro. All symbols tagged with the TNM identifier are considered a group.

UCF Syntax

```
INST instance_name TNM=identifier;
```

*instance_name* can be FFs, All Pads, Input Pads, Output Pads, Bi-directional Pads, Tri-stated Output Pads, RAMs, or Latches.

*identifier* is a value that consists of any combination of letters, numbers, or underscores. Keep it short for convenience and clarity.

Group Elements by Element Output Net Name

Schematic Users (TIMEGRP)

Definition
Specifies a new group with instances of FFs, PADs, RAMs, LATCHES, or User Groups by output net name.
UCF Syntax

TIMEGRP identifier= element (output_netname);

identifier is the name for the new time group.

element can be FFs, All Pads, Input Pads, Output Pads, Bi-directional Pads, Tri-stated Output Pads, RAMs, or Latches, or User Groups.

output_netname is the name of the net attached to the element.

Timing THRU Points (TPTHRU)

Definition
Identifies an intermediate point on a path.

UCF Syntax

INST instance_name TPTHRU=identifier;

NET netname TPTHRU=identifier;

identifier is a unique name.

Pad to Setup

Definition
Specifies the timing relationship between an external clock and data at the pins of a device. Operates on pads or predefined groups of pads.

UCF Syntax

OFFSET=IN time unit BEFORE pad_clock_netname;

[NET pad_netname] OFFSET IN time unit BEFORE pad_clock_netname;

[TIMEGRP padgroup_name] OFFSET=IN time unit BEFORE pad_clock_netname[TIMEGRP reg_group_name];

padgroup_name is the name of a group of pads predefined by the user.
reg_group_name is the name of a group of registers predefined by the user.

pad_clock_netname is the name of the clock at the port.

For more information on Pad to Setup, see the “From the Global Tab Window” section in the “Using the Constraints Editor” chapter.

#### Clock to Pad

**Definition**

Specifies the timing relationship between an external clock and data at the pins of a device. Operates on pads or predefined groups of pads.

**UCF Syntax**

```ucf
OFFSET=OUT time unit AFTER pad_clock_netname;
NET pad_netname OFFSET=OUT time unit AFTER pad_clock_netname;
TIMEGRP padgroup_name OFFSET=OUT time unit AFTER pad_clock_netname [TIMEGRP reg_group_name];
```

padgroup_name is the name of a group of pads predefined by the user.  
reg_group_name is the name of a group of registers predefined by the user.  

pad_clock_netname is the name of the clock at the port.

For more information on Clock to Pad, see the “From the Global Tab Window” section in the “Using the Constraints Editor” chapter.

#### Slow/Fast Path Exceptions (FROM TO)

**Definition**

Establishes an explicit maximum acceptable time delay between groups of elements.

**UCF Syntax**

```ucf
TIMESPEC TSid=FROM source_group TO destination_group time [unit];
```
TIMESPEC TSid=FROM source_group THRU timing_point TO destination_group time [unit];

source_group and destination_group are FFS, RAMS, PADS, LATCHES, or user-created groups.

timing point is an intermediate point as specified by the TPTHRU constraint on the Advanced tab window.

**Multicycle Paths (FROM/THRU/TO)**

**Definition**

Establishes a maximum acceptable time delay between groups of elements relative to another timing specification.

**UCF Syntax**

TIMESPEC TSid=FROM source_group TO destination_group time [unit];

TIMESPEC TSid=FROM source_group THRU timing_point TO destination_group time [unit];

source_group and destination_group are FFS, RAMS, PADS, LATCHES, or user-created groups.

timing point is an intermediate point as specified by the TPTHRU constraint on the Advanced tab window.

**False Paths (FROM TO TIG)**

**Definition**

Marks paths between a source group and a destination group that are to be ignored for timing purposes.

**UCF Syntax**

TIMESPEC TSid=FROM source_group TO destination_group TIG;

TIMESPEC TSid=FROM source_group THRU timing_point(s) TO destination_group TIG;

source_group and destination_group are FFS, RAMS, PADS, LATCHES, or user-created groups.
timing point is an intermediate point as specified by the TPTHRU Points constraint on the Advanced tab window.

**False Paths by Net (Net TIG)**

**Definition**
Marks nets that are to be ignored for timing purposes.

**UCF Syntax**

```
NET netname TIG;
NET netname TIG=TSid1 ... TSidn;
```

**Period**

**Definition**
Defines a clock period.

**UCF Syntax**

```
TIMESPEC TSid=PERIOD timegroup_name time | TSid [unit]
    [HIGH | LOW high_or_low_time unit];
```

*id* is a unique identifier. The identifier can consist of letters, numbers, or the underscore character (_).

*unit* is picoseconds, nanoseconds, microseconds, or milliseconds.

*HIGH* | *LOW* indicates the state of the first pulse of the clock.

**Location**

**Definition**
Locks a user-defined port to a device pin.

**UCF Syntax**

```
NET pad_netname LOC=location;
```

*location* is a device pin identification, for example, P10.
Prohibit I/O Locations

Definition
Disallows the use of an I/O site by PAR (Place and Route) and FPGA Editor.

UCF Syntax
CONFIG PROHIBIT=location1, [location2..., locationn];
location is a pin location identification.

FAST/SLOW

Definition
Assigns a slew rate to a selected port

UCF Syntax
Net port_netname FAST | SLOW;
port_netname is the name of the port.

PULLUP/PULLDOWN

Definition
Signifies a pull level (PULLUP, PULLDOWN, or KEEPER) for a selected output port. KEEPER is used for Virtex devices only. When a tri-state buffer goes to high impedance, KEEPER keeps the input level of the buffer on the pad net.

UCF Syntax
Net port_netname PULLUP | PULLDOWN | KEEPER;
port_netname is the name of the net attached to the port.
DRIVE

**Definition**

This constraint assigns a signal strength to a selected port.

**UCF Syntax**

```
NET port_netname DRIVE=value;
```

*port_netname* is the name of the net attached to the port.

*value* is drive strength (in mA). Values vary for different devices.

IOSTANDARD (Virtex devices only)

**Definition**

Assigns an input/output standard to a selected net attached to the port.

**UCF Syntax**

```
NET port_netname IOSTANDARD=standard_name
```

*port_netname* is the name of the net attached to the port.

*standard_name* is the name of the I/O standard (LVTTL, LVCMOS, and so forth). See the “Attributes, Constraints, and Carry Logic” chapter in the Libraries Guide.

VOLTAGE

**Definition**

Allows you to specify operating voltage. This provides a means of prorating delay characteristics based on the specified voltage.

**UCF Syntax**

```
VOLTAGE=value [units];
```

*value* is an integer or real number specifying the voltage and *units* is an optional parameter specifying the unit of measure.
TEMPERATURE

Definition
Allows the specification of the operating temperature which provides a means of prorating device delay characteristics based on the specified junction temperature. Prorating is a linear scaling operation on existing speed file delays and is applied globally to all delays.

UCF Syntax

\begin{verbatim}
TEMPERATURE=value;
\end{verbatim}

\textit{value} is an integer or real number specifying the temperature in Celsius.